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Landscape Explorer is an application for all those interested in the way the world's surface looks.    It 
enables the user to translate a flat, two dimensional map into a full three dimensional representation 
which can be examined from any viewpoint - go exploring without ever leaving your PC!

The application uses the MDI (Multiple Document Interface) model, and consists of two sub-applications, 
the Landscape Viewer,    module which is used to examine a surface, and the Map Definition module 
which is used to define the characteristics of the surface to be explored.    The items displayed in the 
application menus are dependent upon which module is currently active.

Landscape Explorer is a fairly complex program, but to get a quick idea of it's capabilities it's worthwhile 
having a look at a few sample landscapes first.

This application is Shareware.    If you find it useful you should register the product with WoolleySoft.    
There are significant benefits to doing so - see How to Register  for details.    WoolleySoft also offers a 
range of other services.    Please select here for details.

This copy of Landscape Explorer was officially released on 1st January 1993.    If you are using this 
software on or after the 31st December 1994 you do not have the current version and will be missing out 
on features and functionality.
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Memory Issues 

Landscape Explorer requires fairly large amounts of memory in order to run properly.    If you have less 
than 8Mb of RAM you should have a windows swapfile installed.    If you do not , and this is a good idea 
generally for all windows systems, you can add one using the virtual memory option in the control panel 
'386 enhanced' utility.    Microsoft recommend using the 'permanent' option, and 8 - 12Mb seems to be 
optimal on most computers.

This program was developed on a 486SX25 with 8Mb RAM and an 8Mb swapfile, and has been tested on
a variety of other computers with varying amounts of memory.    I would recommed at least 12Mb of total 
(RAM + Virtual swapfile) memory for routine use.    



What's new in version 1.25 

Support for USGS DEM file import.    This includes all 7.5-minute and 30-minute DEMs, and 1-degree 
DEMs south of 50 degrees north.    7.5-minute and 15-minute Alaskan DEMs are not supported.    

Various other minor improvements to the Map definition tools.    Minor bug fix to map status tool.    



WoolleySoft - Other Services 

WoolleySoft is run by Kevin Woolley, a professional Information Technology specialist with over 10 years 
experience of computer systems and applications at all levels from programming to systems and business
analysis.    Particular areas of expertise include Windows, database systems, networks, and business 
applications.

WoolleySoft is commited to developing stimulating and informative shareware applications.    However we 
can also undertake custom software development and offer consultancy on many aspects of computer 
systems and business.    If you are interested please contact WoolleySoft at 

WoolleySoft, 
Humblesknowe Cottage, Ramoyle, 
Dunblane, Perthshire, FK15 0BA

Scotland 
Tel. 0786 825406 

Kevin can also be reached by e-mail at kjw1@stirling.ac.uk. 

When not working with computers Kevin's time is taken up looking after his young son and climbing all the
mountains in Scotland.    One day he hopes to move to the end of a Kilostream line on the west coast and 
combine all three! 



Quickstart Sample Landscapes 

Landscape explorer comes with maps for the following landscapes already defined.    You may like to go 
exploring!

Crater Lake - crater.map

Crater Lake. Oregan. USA.    This shows the eastern half of the lake, including Wizard island, at fairly low 
resolution.    Crater lake was created when the top of Mount Mazama collapsed during volcanic eruptions 
7000 years ago.    The lake, 8km across, is surrounded by cliffs which rise steeply from the water to form 
a jagged rim in places 600m high.    The area was designated as the USA's 5th national park in 1902.

This map was created by importing a 7.5-minute DEM file into a 7 x 7km map with 90m gridpoints (i.e. 
every third DEM elevation).    See Import DEM for more details about DEM files.

Ben Lomond - lomond.map

Loch Lomond is Britain's largest expanse of fresh water, and the east side of the loch is dominated by 
Ben Lomond.    Relatively easy to climb, and near the population centres of the Scottish central belt, it 
receives a lot of attention from walkers.    It remains however a superb mountain.

This map was created using a scanned image from the Ordnance Survey Landranger sheet 56.

Hebridean Islands - mingulay.map

Mingulay and Berneray are the southmost inhabitable islands in the outer Hebrides, and two of the most 
dramatic.    Both have steep sea cliffs facing into the Atlantic gales.

The last inhabitants left Mingulay (the larger island) in 1934, in a similar manner to the more famous St 
Kilda further west - indeed the lives of the inhabitants must have been very similar both centred around 
crofting and harvesting the seabirds on the cliffs.    Berneray now has nothing beyond a few old lighthouse
keepers cottages.

This map was created using a scanned image from the Ordnance Survey Landranger sheet 31.

Follow the links for further information about viewing,    and defining maps.



How To Register

This application is Shareware.    If you find it useful you should register the product with WoolleySoft.    
Registered users receive the current version of the software (with at least the additional features 
described below), notification of updates, and product support. 

To register your version of Landscape Explorer send £35 to 

WoolleySoft, 
Humblesknowe Cottage, Ramoyle, 
Dunblane, Perthshire, FK15 0BA

Scotland 

We cannot accept credit/debit cards.    Foreign orders should pay by a cheque drawn against a British 
bank (most foreign banks can arrange this), international money order or equivalent, or travellers 
cheques.
For convenience an order from is included with the distributed files.

Additional features in the current registered version (as of 1st January 1993)...

Additional colour schemes for Landscape Viewer - including Winter, Desert and Polar.

Enhanced printing facilities for Landscape Viewer.    The unregistered version prints at screen resolution, 
the registered version prints at your printer resolution.

Direct import of heights data from text files into the Map Definition module.

File analysis function providing further support for US Geological Survey Digital Elevation Model (DEM) 
files. 

Support for Imperial measurements (miles, feet).

Enhanced interpolate heights function in the Map Definition module.

The restriction on re-editing new maps is removed.

We also intend to continue enhancing Landscape Explorer's basic features such as drawing speed, ease 
of use, user customization etc.    Your comments play an important part in determining how this package 
develops - so please support us and we'll support you!
    



Standard Menu

File Menu
Exit

Edit Menu
The edit menu is disable if no modules are open

Options Menu
View Projection
Define Map

Tools
The tools menu is disabled if no modules are open

Window
Cascade
Tile
Arrange Icons
Close All

Help
Help
 



View Projection

Opens a window to display a map using the Landscape Viewer module.    The map to be loaded, and 
initial display parameters are both prompted for.

Multiple copies of this window may be opened, subject to system resource constraints.
 



Define Map

Opens a window containing the Map Definition module.    Only one copy of this window may be opened at 
once.

 



Exit

Exits Landscape Explorer.
    



Introduction to the Map Definition Module

Before viewing a landscape you must define the shape and contents of the surface that you wish to 
examine.    Landscape explorer holds surface information in the form of a rectangular grid.    The grid 
(sample) points hold the heights, whilst the grid (terrain) squares the type of terrain.    The dimensions of 
the grid can be any size from 1 to 99 Kilometres or Miles (depending on the measurement type selected 
when creating the new map) with grid point spacing set by the user so that there are between 400 and 
15,800 sample points.    Realistic looking landscapes usually require 10,000 sample points or more.    Data
is stored in *.MAP files, which are referred to as maps.

It is assumed that you are working from a paper copy of a map and do not have access to digitised 
information, (although a data import facilities for text and USGS DEM files are provided in the registered 
version).

Obviously defining the heights of this number of sample points individually would be a long and tedious 
task, so to speed up this process the map definition module implements a range of tools to help.    
Perhaps the most noteworthy of these is a sophisticated interpolation function that may be used to 
automatically calculate the heights of undefined sample points.

The map definition module is activated by choosing Define Map from the Options menu.    The displayed 
window has three main parts.    A Toolbar that gives you fast access to the different tools you will require 
to define the map.    A Parameter Display area down the left hand side of the window which shows the 
current colour coding for heights and terrain types, and an initially blank area representing the 'Canvas' 
used to define the map.

The Canvas can display three types of information: sample point heights , terrain types and a background
bitmap loaded using the Load Bitmap tool.

Note that the unregistered version of Landscape Explorer functions in metric only, imperial measurements
(miles, feet etc.) are supported by the registered version.

To define a new map the user would typically go through the following steps...

1.      Enter the Map Definition Module by choosing Define Map from the Options menu.

2.      Create a new map of the appropriate size and grid spacing using the New Map tool.

3.      Use the Display Parameters tool to display a full range of colours for the variation in heights 
expected.

4.      Import and size a bitmap copy of the original paper map using Load Bitmap tool.    This would 
typically be created as a .BMP file using a scanner.

5.      Trace sufficient Contours and Define Spot and Block heights so as to give a reasonable definition of 
the shape of the landscape surface.

6.      Use the Interpolate Heights tool to fill in undefined points.

7.      Define any areas that do not contain the default terrain type (low vegetation) using the Terrain block 
or area tools, or perhaps Flooding flat areas with water.

8.      Save the map and view using the Landscape Viewer.



See also: Map Definition Module Menu..



Sample Point Heights Display

When enabled (see Map Function Status) the height of each sample point is displayed as a small solid 
square.    The precise size of the square will vary depending on the display size of the map canvas area, 
but should be optimised to display a large enough square for the colour to be apparent whilst remaining 
small enough so as not to obscure any background bitmap.    No squares are shown for undefined 
heights, and sample points at sea level (zero metres/feet) are always shown as single points.

Landscape explorer uses a range of 15 solid colours to indicate into what range the height of a sample 
point falls.    The current ranges and associated colours are shown in the Parameter Display area to the 
left of the map canvas.    You may adjust the total displayed range using the Display Parameters tool.



Terrain Type Display

There are seven different types of terrain, default or base, water, wood, town, road, rock and sand.
The unless explicitly defined otherwise, all grid squares are assumed to have the default terrain (in most 
colour schemes used by the Landscape Viewer this corresponds to low vegetation) which is not displayed
on the canvas.    Any group of grid squares that does not have the default terrain is shown outlined with 
the appropriate colour.
    



Map Definition Module Menu

File Menu
New Map
Open Map
Save Map
Save Map As
Exit

Edit Menu
The edit menu is disabled for this module

Options Menu
View Projection

Tools Menu
Map Function Status
Display Parameters
Load Bitmap
Set Bitmap Magnification
Set Spot Height
Trace Contour
Set Heights Level
Set Heights to Null
Set Random Heights to Null
Interpolate Heights
Set Terrain (by square)
Set Terrain (by area)
Flood with Water
Move Bitmap
Close Up
Analyse File File
Import Text
Import DEM

Cascade
Tile
Arrange Icons
Close All

Help Menu
Help
    



Map Definition Module Tools

The following tools are available both from the Tools menu and the Toolbar...

Map Function Status
Display Parameters
Load Bitmap
Set Bitmap Magnification
Set Spot Height
Trace Contour
Set Heights Level
Set Heights to Null
Set Random Heights to Null
Interpolate Heights
Set Terrain (by square)
Set Terrain (by area)
Flood with Water
Move Bitmap
Close Up
Analyse File
Import Text
Import DEM
    



New Map

Creates a new map.    A dialog box prompts for the measurement type (metric or imperial), length, width 
and grid spacing.

Note that the unregistered version of Landscape Explorer allows only metric measurements to be 
selected.
      



Open Map

Opens an existing map file.    A dialog box prompts for a *.MAP file to be selected.



Save Map

Saves changes to the map you have been working on. 

When you choose Save, the map remains open so you can continue working on it. 



Save Map As

Saves a new or existing picture as a .MAP file.

When you choose Save As, the map remains open so you can continue working on it.



Map Function Status

Displays a dialog box showing the map name, size, sample point spacing, grid size, and the bitmap 
displayed (if any).

A set of check boxes allows the user to choose which of the background bitmap, height and terrain data to
display.    However as the data type manipulated by the currently selected tool must be displayed, one of 
these check boxes may be disabled.
      



Display Parameters

Displays a dialog box that allows the user to set the height range for colour display.    This defaults to 0 - 
1000 metres/feet.

This dialog also allows the user to set the default terrain type used by the terrain and close up tools.    This
can also be set directly by clicking on the chosen default terrain in the Parameter Display area of the 
window.
      



Load Bitmap

This displays a bitmap, typically a scanned image of the original paper map, as background.    A .BMP file 
is prompted for by a standard 'open file' dialog.

The bitmap may be moved using the Move Bitmap tool, and it's magnification altered by the Bitmap 
Magnification function.

All sample point heights and terrains are displayed (if enabled - see Map Function Status) superimposed 
on the background bitmap, which is typically used as a template for defining map information.    
      



Set Bitmap Magnification

Prompts for the bitmap magnification to be used in pixels per kilometres or pixels per mile, and defaults to
50.    The value to be used may be calculated, but as it depends on the precise characteristics of the 
original scan is probably best arrived at by trial and error.
      



Set Spot Height

Prompts for the height of the sample point selected.    Enter either null or a height between 0 and 9999 
metres/feet.

Note that the unregistered version of Landscape Explorer only allows maps to be defined using metric 
measurements, the registered version also allows imperial measurements (miles, feet etc.) to be used.

      



Trace Contour

Allows a series of sample points along a line to be set to the same height.    Typically this tool would be 
used to trace the contour lines on a bitmap loaded as background.

The tool uses a combination of the left and right mouse buttons.    To start a contour press the left mouse 
button.    You may now either move the mouse whilst holding down the button, or release the button and 
click again at another position.    In both cases a red line highlights where the contour will be placed.    
Continue defining the contour using any combination of these actions until complete, then click the right 
button.    A dialog box prompt for the height of the contour, which must be between 0 and 9999 
metres/feet.
      



Set Heights Level

Click and drag using the left mouse button to define a rectangular area.    On release a dialog box prompts
for a height between 0 and 9999 metres/feet to which all sample points within the area will be set.
      



Set Heights to Null

Click and drag using the left mouse button to define a rectangular area.    On release a dialog box prompts
for confirmation that sample points in the defined area are to be set to null.
      



Set Random Heights to Null

Click and drag using the left mouse button to define a rectangular area.    On release a dialog box prompts
for confirmation that a random 50% of sample points in the defined area are to be set to null.
      



Interpolate Heights

This tool will interpolate the heights of undefined (null) sample points for either the whole map or a 
selected area.

Interpolation uses a combination of recursive bezier curve and trend analysis to calculate missing heights.
A smoothing transform may also be applied.

The proportion of defined to undefined sample points required depends on the kind of landscape being 
defined.    For smooth, rounded hills or plains reasonable results may be obtained with 1 point in 20 or 
less.    For more complex structures 1 in 5 or less is recommended.    Interpolation is most accurate where 
the surface has few discontinuities - so for a valley with steep sides and a flat bottom placing two or three 
contour lines along the sides will be sufficient to derive the shape of the sides.    However, in the absence 
of other information the interpolation function will assume a continuation of the sides to form an 
overdeepend vee, so you will need to block in some of the valley floor.

An minimum height setting is available for the interpolation function to help defining sea coasts and other 
areas of water.    This cannot be altered from sea level (zero height) in the unregistered version.    So to 
define an island draw the appropriate contour lines and spot heights for the island, and an area of sea at 
zero height for two or more sample points around the coast before applying interpolation.

Note that you should try to define as many grid points as possible on the edges of the map, and 
particularly at the corners.    This is because in the body of the map the function can interpolate data from 
all directions, whereas at an edge the available data, and hence accuracy, is more limited.
      



Set Terrain (by square)

Allows terrain squares to be 'painted' to a particular terrain type by moving the mouse with the left button 
held down.    Squares are set to the active terrain type, which can be set either using the Display 
Parameters dialog or clicking on the required terrain type in the Parameters Display area.
      



Set Terrain (by area)

Click and drag using the left mouse button to define a rectangular area.    On release a dialog box prompts
for the terrain type to which all the terrain squares in the defined area will be set.
      



Flood with Water

Flood fills :-) any flat area of the map with water.    After defining the shape of your landscape click on a 
suitable terrain square.    If the four bounding sample points define a flat square (with non null) a dialog 
will prompt for confirmation that all contiguous flat terrain squares at the same height are to be set to 
water.
      



Move Bitmap

This allows a bitmap to be moved under the grid.    Grab the bitmap using the left mouse button and 
release when positioned correctly.
      



Close Up

This tool allows the user to select a 11 x 11 area of grid points for display in a subsidiary window.

The selected area may be scrolled over the map.    The close up window must be closed before work can 
continue with the main Map Definition window.

The close up window always displays heights and terrains, and may display the background bitmap if 
display for this is enabled.    Within the window the left mouse button is used for heights and the right for 
terrains.    A single click in sets the corresponding height or terrain to the default, whilst a double click 
displays a dialog box that allows the height or terrain to be set to a specific value - which then becomes 
the default. 



Analyse Import File

This tool is used to analyse a data file prior to import to facilitate correct setting of map parameters.    
Version 1.25 of Landscape Explorer can only analyse US Geological Survey digital elevation model 
(DEM) files. 

Full details of DEM file formats can be obtained from the US Geological Survey (if you have access to 
mosaic and the internet their World Wide Web server is well worth a visit), however they basically consist 
of a set of parallel profiles arranged south to north, each profile being a one-dimensional array of 
elevations arranged west to east, thus describing a quadrilateral area.    DEM files can be obtained from 
USGS and various anonymous ftp sites - a good selection of 7.5-minute DEM's are available from 
spectrum.xerox.com. 

USGS produce the following types of DEM file:-. 

7.5-minute DEM
7.5-minute quadrangle.    Horizontal coordinate system uses UTM on North American Datum of 1927 
(NAD 27) or 1983 (NAD 83).    Elevations are referenced in metres or feet to the National Geodetic 
Vertical Datum of 1929 (NGVD 29) in the continental US, and to local mean sea level in Hawaii and 
Puerto Rico.    Spacing of elevations along and between each profile is 30 metres, and the profiles may 
not always have the same number of elevations because of the variable angle between true north and the
grid north of the UTM coordinate system. 

30-minute DEM
30- by 30-minute block.    Horizontal coordinate system is Geographic (lat/long) on NAD 27 or NAD 83.    
Elevations are referenced in metres or feet to NGVD 29 in the continental US, and to local mean sea level
in Hawaii and Puerto Rico.    Spacing of elevations along and between each profile is 2 arc seconds. 

1-degree DEM
1- by 1-degree block.    Horizontal coordinate system is Geographic (lat/long) on World Geodetic Survey 
(WGS) 72 or WGS 84.    Elevations are referenced in metres in the continental US and Alaska, and to 
local mean sea level in Hawaii and Puerto Rico.    Spacing of elevations along and each profile is 3 arc 
seconds.    Spacing between profiles is 3 arc seconds south of 50 degrees north, and 6 or 9 arc seconds 
above this.    DEMs north of 50 degrees are not handled correctly by Landscape Explorer version 1.25.    

7.5-minute and 15-minute Alaska DEM 
These DEMs    are not handled correctly by Landscape Explorer version 1.25. 



Import Text

This tool allows the user to import a set of heights data from a textfile (for example data exported from a 
spreadsheet), and is only available in the registered version.    Version 1.25 of Landscape Explorer can 
only import ASCII/ANSI space delimited text - i.e. a text file which you can view using Notepad or Write 
(with no conversion) and consists of numbers separated by spaces or newlines.    This type of file is, for 
instance, created by the Lotus 1-2-3 extract function. 



Import DEM

This tool allows the user to import a set of heights data from a US Geological Survey digital elevation 
model (DEM) file. Further information about DEM file formats is available under the Analyse File function.

A typical DEM file will contain many more grid points than Landscape Explorer can handle directly.    The 
function therefore presents a dialog box that allows the user to specify an X,Y offset and sampling 
frequency that will be used to process the DEM file, thus importing either a small area of the file at high 
resolution or a larger area at lower resolution.

Note that 7.5-minute DEMs may have differing numbers of elevations per profile, particularly for the first 
and last few profiles.    In this case it is advisable to apply offsets that will not import data from these 
profiles.



Introduction to the Landscape Viewer Module

This module displays a view of a previously defined map in a window.    The map may be viewed from any
direction using a variety of different drawing schemes such as simple grid, summer colours, winter colours
etc. (some of which are disabled in the unregistered version).    The position of the light source may also 
be moved    and you will probably wish to try varying some or all of these features to obtain the best 
results.

Multiple copies of the Landscape Viewer module may be opened, subject to system resource constraints. 
The map to be loaded and initial display parameters are prompted for after selecting the View Projection 
item from the Options menu.

As drawing the landscape may take a significant amount of time (this depends on your system, the size of
the map grid, and the drawing scheme selected), a modeless dialog box is displayed showing the 
percentage completed.    Clicking on the 'Cancel' button stops the drawing.

See also Landscape Viewer Module Menu..



Landscape Viewer Module Menu

File Menu
Save Picture
Save Picture As
Print
Printer Setup
Exit

Edit Menu
Copy

Options Menu
View Projection
Define Map

Tools
Set Parameters

Window
Cascade
Tile
Arrange Icons
Close All

Help
Help



Save Picture

Saves changes to the picture you have been working on. 

When you choose Save, the Landscape Viewer module remains open so you can continue working with 
the projection.



Save Picture As

Saves a new or existing picture as a .BMP file.
When you choose Save As, the Landscape Viewer module remains open so you can continue working 
with the projection. 



Print

Prints the current view of the map.    The quality of output differs between the unregistered and registered 
version:- the former prints at screen resolution, whilst the latter prints at the resolution of your printer.    On
Mono printers the basic grid often gives the best results, and you can adjust the size of the printed image 
using the Magnification control in the Set Parameters Dialog.



Printer Setup

Selects a printer and sets printer options for Landscape Explorer before printing. The available options 
depend on the printer you select. 
 



Copy

Click and drag using the left mouse button to define a rectangular area that will be copied to the clipboard.
 



Set Parameters

Displays a dialog box that allows the user to set the parameters that will be used to draw the current 
projection of the map.    If any values are changed the projection is redrawn. 

The following parameters may be set.

Projection Viewpoint
This describes the viewer's position in terms of altitude and azimuth.    Altitude may range from 0 to 90 
degrees where 0 is horizontal with and 90 vertically above the map.    Azimuth ranges from 0 to 355, 
corresponding to the compass bearing.

Light Source Position
Describes the light source position in a similar manner to the Projection Viewpoint.

Vertical Scaling
The default setting (left of the slider) draws the projection completely to scale.    However with flat 
landscapes it may be useful to exaggerate changes in height.    Moving the slider to the right increases the
vertical scaling by a factor of up to ten times.

Magnification
The default setting (centre of the slider) sizes the projection to fit comfortably within the window.    This 
can be changed to give a larger or smaller    drawing by suitable positioning of the slider bar.    A range of 
20% to 200% of default size is available.

Colour Scheme
The following colour schemes are available:

Plain Grid: Draws the grid squares as simple open quadrangles.    Light source and terrain are ignored.    
This option works best for landscapes with relatively few grid points.

Summer:    Draws the projection to give an impression of a temperate climate landscape in summer.    
Includes light source and terrain information.

Winter:    Draws the projection to give an impression of a temperate climate landscape in winter, with snow
covering the higher ground.    Includes light source and terrain information.    This option is not available in 
the unregistered version.

Desert:    Draws the projection to give an impression of a hot desert landscape.    Includes light source and
terrain information.    This option is not available in the unregistered version.

Polar:    Draws the projection to give an impression of a polar landscape.    Includes light source and 
terrain information.    This option is not available in the unregistered version.



Arranging Windows and Icons
This set of menu items implement the standard Windows MDI Cascade, Tile, Arrange Icons, and Close All functions.






